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1. Introduction to Kernel for Outlook PST Repair

Welcome to the User Manual of Kernel for Outlook PST Repair, the most efficient and user-friendly Outlook PST
recovery software, which repairs brutally corrupted, inaccessible, or deleted PST files, and extracts every single data
item like emails, appointments, tasks, journals, contacts, sentitems, or calendar, etc. The software is equipped with
dynamic features and holds a rich graphical interface, which is necessary for rendering an outstanding user
experience.

1.1 Using this Manual

This User Manualisintended to guide users on using Kernel for Outlook PST Repair. We suggest that first time users
should read this User Manual completely and carefully before proceeding to use the software. However, if you are
an experienced user, you can use the Table of Contents to find out information pertaining to the tasks that you
need to perform by using Kernel for Outlook PST Repair. You can use the Table of Contents to navigate through
different sections of this User Manual. The Table of Contents enlists all the sections contained within this user
manualin chronological order.

1.2 About Kernel for Outlook PST Repair

Kernel for Outlook PST Repair is an advanced and professional PST repairing tool thatis designed to providean
effortless PSTfile recovery solution when the PST file gets corrupted, damaged, or accidentally deleted. It is
blended with various advanced functionalities and options that help in recovering the corrupt PSTfiles from the
scenarios like:

e Registry Errors

e Hard Drive failure

e Abruptsystemshutdown
e Outlookcrashes

e Virus attacks

Kernel for Outlook PST Repair offers a varied range of saving options to save recovered PST data files. In addition,
you can migrate the entire mailboxes of MS Outlook to the most popular email servers, Web-based email
applications, and cloud services.

The Kernel for Outlook PST Repair software efficiently recovers and retrieves all the necessary data files such as
Notes, scheduled tasks, appointments, Calendar entries, Journal, Drafts, Deleted Items folders, etc. Itis empowered
with QFSCI algorithms, which strictly helps in preserving the properties, formatting, and email metadata, like To,
Subject, CC, BCC, From, of the recovered email items.

Latest Enhancements to Saving Options:

Kernel for Outlook PST Repair has been upgraded to support a variety of saving options. After the recovery of PST
data files, you can open and view the recovered Outlook PST files on MS Outlook, Outlook Express, Ado be Reader,
and many other applications as it supports a variety of other file formats. Furthermore, the software is configured
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with some latest storage facility, which further allows easy transfer of the repaired PST items to productive Web -

based email software’s and email servers.

Despite this, the following list divides the saving alternatives on the basis of applications and the quantity of files
processed.

Single File Options - PSTfile (MS Outlook), DBX file (Outlook Express), and MBOX file.

Multiple File Options—MSG File, EML file, TXT file, RTF file, HTML file, MHTML file, and PDF file.

Email Servers - GroupWise, IBM Domino (Lotus Domino), Microsoft Exchange Server, and Office 365.
Web-Based Email Clients - Gmail, Google Apps, Yahoo, AOL, Hotmail.com, Live.com, Outlook.com, iCloud,
and company IMAP account.

1.3 Salient Features

Salient features of Kernel for Outlook PST Repair software include:

Adeptly repairs PST data files along with its data items like deleted emails, folders, appointments, tasks,
notes, calendar, journals, drafts, emails, etc.

Proficiently recover emails from encrypted as well as password-protected PST files
Recovers the permanently deleted or accidentally deleted emails of PST files
Preserves email metadata, such as To, From, Subject, Time, CC, BCC, Date etc.

Provides advanced save facility that enables the migration of recovered PST files on email servers like IBM
Domino, MS Exchange Server, Novell GroupWise, and company IMAP account

Facilitates the storage of recovered PST files to OWA or Office 365 cloud-based application

Efficiently convertsthe recovered PSTfiles to Apple mail supported MBOX format

Integrated with an option of saving the recovered PST email items to the well-known Web-based email
applications like Gmail, AOL, Yahoo, iCloud, Hotmail, Google Apps, Live Mail, and Outlook

Proficiently recover attachments, zipped attachments, and images from corrupt PST files
Embedded with Find functionality for easingthe PST email search operations

Provides multiple saving options, which includes various file formats like PST, MBOX, TXT, RTF, HTML, MSG,
MHTML, DBX, IMAP, PDF, and EML

Integrated with Save and Load Snapshot options, which helpsin capturing the PST file recovery process and
subsequently helpsin loading the same process further in the future

Offers advanced email filter options for refined segregation of email items on the basis of date-range option

Completely restores the formatting, properties, and structure of PST data files

Merged with an option to generate File Analysis Reports that unambiguously capturethe graphical reports
on totalitem types, Mail flow density by date or senders, and interaction between users

[KERNEL &
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e Allows easy previewing of recovered PST data files and savingin various different saving options PST, MSG,
DBX, and EML

e Embedded with preview technology
e Offers the 30-day money-back guarantee

e Availablein the free trial version

2. Getting Started

Now thatyou have understood thefeatures and potential of Kernel for Outlook PST Repair, you are ready toget a
hand on experience of the software. To initiate the PSTfile recovery process, at first you need to download and
then install the software. But, before downloading and installing the software, it is strictly advised to scanthe
installation pre-requisites for ensuring that the systemis appropriately configured to run the software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for Outlook PST Repair can be broadly classified into two
major categories — Hardware requirements and Software requirements.

2.1.1. Hardware Requirements:
The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum512 MBRAM
e 20 MB for Software installation
e Disk Space - Enough space to store the repaired files
2.1.2 Software Requirements:

The software requirements for installing the software are as follows:

Supported MS Windows Operating System: Windows XP, Windows Vista, Windows 7, Windows 8, Windows 8.1,
Windows 10, Windows 95/NT, Windows XP, Windows Server 2000, Windows Server 2003, Windows Server 2008,
Windows Server 2008 R2, and Windows Server 2012

Supported MS Outlook Versions: MS Outlook 97,98, MS Outlook 2000, MS Outlook 2002, MS Outlook 2003, MS
Outlook 2007, MS Outlook 2010, MS Outlook 2013 and MS Outlook 2016

2.2 Downloading Kernel for Outlook PST Repair for the First Time

After checking your computer with the prescribed system requirements for Kernel for Outlook PST Repair, you can
download andinstallthe software on yourcomputer. Ifyou want to try using Kernel for Outlook PST Repair software
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before  buying it, you <can download the evaluation version from the following link:
https://www.nucleustechnologies.com/outlook-pst-repair.html

W, The free trial version of Kernel for Outlook PST Repair tool permits you to recover data from
an infected or damaged PST file but restricts you from saving more than 25 email items of
each folder.

2.3 Install Kernel for Outlook PST Repair

After downloading the installer file for Kernel for Outlook PST Repair, you can install the software by running the
file. To install Kernel for Outlook PST Repair, perform the following steps:

e Double-click the Kernel for Outlook PST Repair software installer file.
e Followthe on-screeninstructions. The Setup Installation Completion screen will be displayed.

e Click Finish to launch the software. The main window of the software appears.

2.4 Start Kernel for Outlook PST Repair

To start Kernel for Outlook PST Repair software, Click Start > All Programs > Kernel for Outlook PST Repair

Alternatively, you can launch Kernel for Outlook PST Repair by double-clicking the shortcut icon available on the
desktop and Quick Launchicon.

2.5 Uninstall Kernel for Outlook PST Repair

You may need to uninstall and re-install Kernel for Outlook PST Repair. To uninstall Kernel for Outlook PST Repair
software,

1. Click Start > All Programs > Kernel for Outlook PST Repair > Uninstall Kernel for Outlook PST Repair
A warning message will be displayed.

2. Click Yes to uninstall Kernel for Outlook PST Repair.

B’ Before proceeding to uninstall Kernel for Outlook PST Repair software, you must ensure that
the software is not running.

You can alternatively uninstall Kernel for Outlook PST Repair from the Control Panel by performing the following
steps:

1. Click Start > ControlPanel, and then double-click Add or Remove Programsicon.
2. Select Kernel for Outlook PST Repair and click Remove.
A warning message will be displayed.

3. Click Yes to uninstall Kernel for Outlook PST Repair.
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3 Software Interface

Nowthat Kernel for Outlook PST Repair has been installed on your computer, you can start using the software after
getting acquainted with the software interface.

3.1 Menu-bar

The menu bar of Kernel for Outlook PST Repair comprises of four menus—File, View, Find, and Help.

3.1.1 File Menu

The File menu of the software appears as:

[File | View Find Help

s | Select File... Ctri-R

H Save Ctrl=S
Exit

Figure 3.1 File Menu

Following table enlists the options availablein the File menu:

Select File |Opens “Source File Selection” dialog so that you can select or search
source PSTfile

Opens “Select Output Type” dialog so thatyou can select required
saving option
Exit Click to exit from the application

Save

3.1.2 View Menu

The View menu of Kernel for Outlook PST Repair software appears, as shown in following figure:

View | Find Help

|I| Status Bar
Task Bar

Figure 3.2 View Menu

Following table enlists the option available in the View menu:

Status Bar Selecting this option displays the status bar
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Task Bar Selecting this option displays the task bar

3.1.3 Find Menu

Find menu expands over Find Message bar to assist the user:

Find | Help

"% | Find Message

Figure 3.3:Find Menu

Find Message Let you search messages from PST file

folders

3.1.4 Help Menu

The Help menu of Kernel for Outlook PST Repair software appears, as shown in the following figure:

Help
Abhout
Software Help Ctrl=H

Figure 3.4 Help Menu

The following table enlists the options availablein the Help menu:

About Displays version and supportrelated information about the
software
Software help Displays User’s Help Manual for Kernel for Outlook PST Repair
IKERNEL A
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3.2 Tool-bar

The toolbar is located just below the menu-bar of the software interface. It offers a convenient and interactive
method for performing varied functions that are otherwise performed by using the Menu Bar. The following
buttons are highlighted in the toolbar, and each button has their respective functionalities:

Opens “Source File Selection” dialog to browse

lL_ Select:File or locate source corrupt PST file

IB siore ' Opens “Select Output Type” dialog, which
[P helps in selecting the required saving options

Saves a snapshot of the PST recovery instance

[ e—
“@ Samenarnt ‘ to the desired location.
(=) Loads a previously saved snapshot from the
UEA, Load Snapshot ‘ . .
specified location
(3 F_nd‘ Allows easy searching of required emails from
. I
[Cre—r) selected PSTfile
|®He;‘ Displays User’s Help Manual for Kernel for
Outlook PST Repair
SR Navi .
’ SoyiOmlise | avigates to the online purchase portal of the
o0 software

3.3 Button Used

Kernel for Outlook PST Repair comprises various buttonsin both Left and Right pane. Below we have mentioned
the buttonsin detail.

3.3.1 Left-Pane

Left Pane of Kernel for Outlook PSTenhances the viewing experience of the PSTfile recovery process as it
renders the preview of recovered PST email items in a tree-like hierarchical structure. You can navigate
through various folders and files that were extracted after stringent PST file recovery process. The retrieved
files and folders are displayed like thisin the Left Paneas shownin the screenshot given below:
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Folder List
= B W D:psTipst file.pst
O3 1PM_COMMON_VIEWS
0. SexchRoc
= [ Top of Personsl Folders
O3 (8y Category)
03 (Growp Calendars)
O3 (My Contacts)
[ 4 (Rues)
- O (Todo's
[ By Category)
05 Alarms
[ Y
[0 3 Dedeted ftems
= [0 pocuments and Settings
= 3 hemd
= [J2 Desitop
- O rsf pst
= DJ pst fle.pst
Oa (eyca
03 (Gox
O My Ce
O3 (Rues
= .4 (Todo
O ey
O3 Alsrrre
O«
0.3 Delste

< >

@|a|o|s|ale

Figure 3.5: Left-Pane

In addition to this, there are some additional buttons placed at the bottom in the Left Pane, which is mentioned
below in the following table:
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Calendar Shows Calendar View in Right Pane

_E Contacts Shows Contacts and related information in Right Pane
_E Tasks Shows Tasks in the Right Pane

—; Journal Shows Journalsin the Right Pane

-? Notes Shows Notes in the Right Pane

@ Up Displaysthe Folder Path pane in the Left Pane
Down Hides the Folder Path panein the Left Pane

3.3.2 Right-Pane

Right Pane of Kernel for Outlook PST Repair displays every single email item in the folder or file selected from the
Left Pane. The Right Paneis again divided into three different panes (as shownin the image below):
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Figure 3.6: Right-Pane

Display Pane - Enlists the email items available in the folder you have selected from the Left Pane:

E Save list information | Allows you tosave the list information in HTML
to html file format
ﬂ Stop current process Stopsthe current process
W Show/hide calendar
g / . Shows or hides the calendar view in Display Pane
view
Eﬂ Show ane day Shows the calendar entries for a particular day

Shows the calendar entries for five days

)

Show working days

7 Show weekdays
Shows the calendar entries for the entire week

]

Show month days Shows the calendar entries for the entire month

|

Savein MSG Saves the listed email items in MSG format
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“3173| Savein EML Saves the listed email items in EML format

‘ : Savein TXT Saves the listed email items in TXT format
@ Savein RTF Saves the listed email items in RTF format
Savein PDF Saves the listed email items in PDF format
'@' Savein HTML Savesthe listed email items in HTML format
|1:J| Save in MHTML

= Savesthe listed email items in MHTML format

Preview Pane-Shows the preview of contents of email items selected in Display Pane.

Task Pane —Displays the varied range of Save Options along with the display of the File Analysis Reports section.
The Task Paneis further sub-divided into five different sections that are mentioned in the following bullet points:

e Saving Options (Single File) — PSTfile, DBX file, and MBOX file
e Saving Options (Multiple Files) — MSGfile, EML file, TXTfile, RTF file, HTML file, MHTML file, and PDF

e Saving Options (Email Servers) — Office 365, GroupWise, IBM Domino (Lotus Domino), and Microsoft
Exchange

e Saving Options (Web-Based Email Apps) —Gmail, Google Apps, Yahoo, AOL, Hotmail.com, Live.com,
Outlook.com, iCloud, and Company IMAP Account

e File Analysis Reports —Total item types, Mail flow density by date, Mail flow density by senders, and
Interaction between users
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Tasks Pane o x

Saving Options (Single File) *
| &| PSTfile ( MS Outlook )

I£) DBXfile ( Outlook Express )
-y MBOX file

Saving Options (Multiple Fil... *
§9 MSG file

21 EMLfile

G T file

G RIF file

I HTML file

5] MHTML file

PDF file

Saving Options (Email Servers) *
[} office 365

Q GroupWise

3¢ IBM Domino { Lotus Domin...
Microsoft Exchange Server

Saving Options (Web Based ... *
84 Gmail

84 Google Apps

24 vahoo

5 AOL

@ Hotmail.com/Live.com/Outl...

& icloud

@ Company IMAP Account

File Analysis Reports i
@ Total item types
K& Mail flow density by date

Figure 3.7:Task Pane

4.Using Kernel for Outlook PST Repair Software

Kernel for Outlook PST Repair performs the flawless recovery of inaccessible or damaged PSTfiles and saves
the recovered data files to the various different locations like Web-based email apps, Email servers orin the
latest available file formats, including PST, DBX, and EML. You can view theserecovered email items on the
MS Outlook as well as Outlook Express applications along with the variety of other applications.
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4.1 Quick Scan

Using Kernel for Outlook PST Repair, you can efficiently repair PST datafiles and extracts the email dataitems
from inaccessible PSTfiles. The software creates a new PST file with the extracted data from corrupt PST file and
savesthe same at a user-defined location. Mentioned below are the stepsto repair PST file using the Kernel for
Outlook PST Repair software:

1. Click Start > All Programs > Kernel for Outlook PST Repair >Kernel for Outlook PST Repair
to launch the software. The main window of the software appears:

@
. e e
S w D I L)/ C S
Vo L0 ENANRIRNGwLO8 .
N " aeo v Oentem o e — Vo g g
» » ol LR
—t 18 10 Sohe e S
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* s Q -
R e T e P L
8 ~anei = -
8
-
R
) Ve e
Sape |®{Zle 1 e -

Figure 4.1: Main Screen of Kernel for Outlook PST Software

2. Click the Browse button to select the PST file, if you already know the location of PST file. However, if you
do not know the exact location of PST file, click the Search button, and “Search PST file(s)” dialog box

appears.
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Search PST Filefs)

Click Erowse Dution 10 sefect and list the path for PST e, After path selection, dick
Search button 1o iocate the PST Mlela).

Fie Nove

gK Carcel

Figure 4.2:Search PSTFile (s)

3. Click the Browse button to select the folder where you want to search for the PST file. After selecting the
required drive, click the Search button.

Search PST tilegs)

C:\Documents and Settings\suyogv\Local Settings\Application
Data\Google\Cheome\User

Data\Detault\Latensions\nmmhkiegccagdidgiimedpicomgmieda\0L1.0.0_00_locales\

[ - & Stop

S

Fde Name

Figure 4.3:Scanning Drive for PST Files

4. Software will enlist the PSTfiles found in the selected drive:
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Search PS1 File(s)

Please select the path for searching. using the Browse button and dick the Search
button

[DAPST 5 Buowse | |G Sewch

Fie Name |

D\PST\pat fie pat
DAPST\MAILBOX - ADMINISTRATOR[1) PST
DAPST\archive. pst

oK | | Concel |

Figure 4.4: Available PST files enlisted

5. Select the required file and click the OK button.

6. The selected PST file will get enlisted in the “Source File Selection” dialog. Apart from this, you can
add multiple PSTfiles, and then subsequently select Repair Multiple File(s) option for repairing multiple

PST files:
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Source File Selection x

Select Source or Load Snapshot Y,
Proate seloct source PST Ml 1o repar load snapshet or find PST the(s) | ‘/

« Repai Single File : |0 \PS Tharchive gat | |5 Browe | G Seach
Repair Multiple File(s) :

Fio Name 4+
[}

Load Snagshat Only

To know mors abod the step, lsase chck hae, News | | Carcel

Figure 4.5: Select corrupted source PSTfile dialog

= Note: Alternatively, toload a previously saved snapshot, select Load Snapshot Only
checkbox and click Next to load the snapshot.

7. Click the Next button, the “Select Recovery Mode” window s displayed. The “Select Recovery Mode”
window displays all the available options of repairing and saving the PST datafiles.

Select Recovery Mode x

Process Information
Please read the folowing nformaton . Cick fresh 10 start repairing process

E

* Once the recrared data i chiglaped 1 el pane, You Can 3P the $0an (oces anptme. Hete pou Can 3ave L 10 tht Dot of bet
e scan geocess freth

= Aller scanning the selected PST file thoscughdy, sottwate vl diaplay all iecovesable data ncluding Lost and Deleted dome n 1ed
color, All these Lost/ Deletad Roms in 16 color ave also recoverable

= ‘You can also cpit the FST He on the basis of dete range. file axe of folder tize

* Soltwaie Can 2ave recovered emad dorss 10 vanows lonsats Lo, PST, DR EML MSG, MBOGC IMARIGs Google Dave). TXT,
RIF, HTML,. NHTML andd FDF

* Indrvidusl emad Rema can be saved 10 EMUMSE TXT ATF POF HTML and MHTML format

Lo know poie sbout this sieo. pleaie chch hers., | «<Back | Frsh || Coreel

Figure 4.6: Select Recovery Modedialog
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8. Click Finish to startthe scanning/repair process.

Processing...

(™ =

Step5of 6.

Shortcuts

Searching for Lost/Deleted folder(s) and item(s). If you do not want to
recover lost/deleted data then you can skip this process.

Figure 4.7: Repairing process dialog

9. After the scanning process gets completed, the recovered email items will get enlisted in the Left Pane.
Select any folder to view the contentsin Right Pane.

o Barmel b Ot 10T Pepon
- e T
. Gt Bb- o beaiamnst 4L ht et A ted (B oew Tty 0o
"o 4 » * \L/ "
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gé: PUSE S TS o o v fem * Mt - -'--'-’l Wt
. »
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& ot 'E e e tpye— 4..3‘
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7 vt . e e

B2 covertur vt Copy: Appontmant
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4 DETDAE P 0 N
™ 190 W P 00 b
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Figure 4.8: Preview Window
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10. Select the folder from the Left Pane and click the Savebutton to proceed with the saving process of the
recovered emails. By clicking the Save button, the "Select Output Type" dialog boxappears on the screen.

Select Output Type *

Sedect the output type 10 save the recovered data,

38 HTML fe

FMHTML fe

I8 POF S

Emadl Servers

) Offce 35

() Grogrease

0 1EM Domerw [ Lotus Domno )

[ Microsoft Exchange Server

Web Bosed emad chonts

M Gl

S Googie Agp:

& ahoo

8 A0L

0] Hownad com/Live com/outiosk. com
8 Ot

e Company INAP Accournt %

To know sen aboct 3 step, plaage chck here, SN iy Cancel

Figure 4.9: Select Output Type

11. Select the required format or location in which you wish to saveand view the recovered data. Click the
Next button to continue.

12. Select the desired location where you wish to save the newly created databasefile. The software will start
savingthe recovered data at the desired location.
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Please wait while current process finishes...

Saving 60 of 907

Saving Folder : Top of Personal Folders\Inboxh

article for writeup

Cancel

Figure 4.10: Saving Emails

13. After the recovered items get saved, the software displays the following message.

,
Saved Files (oS

New PST file [s] saved successfully at:

To add PST file(s) in MS Outlook, follow these steps:
Open MS Dutlook >> Goto File Menu >> Click Dpen >> Select Open Data File >> Browse and select PST
file from drive

File Name Qutlook Store Name
E:\RECOVEREDADMINISTRATOR - 49.PST RECOVEREDADMINISTRATOR - 49
| i
e |

Figure 4.11:Saved Files
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5.Saving Options

Finally, you have extracted the email data items from inaccessible and corrupted PST files, now you must save
the recovered data files. Kernel for Outlook PST Repair offers the following distinct saving optionsto save and
access the recovered PST files:

| Seloct Output Type x*

Selact the oulput type 10 save e recovered data

Single Fde

& PST e [ MS Dutiock )
(23 DO e |0usiook. Expesss]
LAMEBOX e

Huliple Files
2508
{2 ENL e
v 1T le
b RTF e
38 HTML fis

1) MHTHL Ne

B8 FOF fie

Emad Servers
) Oce 25
&9 Gooupense

1k 1BM Doenre | Lotus Dormino |

Yo know soes dbonst g shap plaare chok heve

Figure 5: Saving Options Window
e PST File (MS Outlook): This option allows you to save recovered email datain MS Outlook.

e DBX File (Outlook Express): This option lets you to save recovered email datain format supported by
Outlook Express.

e MBOX File: This option permits you to save the recovered email datain MBOX file format

The software also allows user to save the recovered individual email items in EML, MSG, TXT, RTF, PDF, HTML
and MHTML formats. Apart from this, you can migrate the recovered email items to the popularemail servers
and Web based email applications. In addition, you can initiate this migration facility by clicking the Email
Servers or Web Based email clients sections, which are presentin the task pane.
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Select Output Typs *

Sedect the oultput type 1O save the recovered data,

38 HTML fe

F I MHTML e

POF Se

Emadl Servers

) Office 365

€9 Giougpease

ot 1EM Domed [ Lotus Doneno )

|} Microsolt Exchange Server

Web Based emad chonts

N Gl

S Google Agpe

25 Yahoo

8 A0L

0| Hotmad com/Live com/outiook. com
8 Ot

& Company INAP Account =

Toknow moe aboct $4; e, plame clck here S 0 o Cancel
Figure 5.0: Saving Options Window (Contd..)

5.1 Save In PST

In orderto access datawith MS Outlook, you can savethe recovered email items in PST, MSG, and EML
format. Select the PST file (MS Outlook) option to savethe recovered datain PSTfile format. The step-by-
step procedurefor savingthe recovered data in PSTfile format is depicted in the following instructions given

below:
1. After the definite recovery of PST email items, select the PST file (MS Outlook) option and click the Next
buttonin the “Select Output Type” dialog box.

Select Qutput Type ﬂ

Seloct the output type to save the recovered data.
e o |
| = ]PST fle (M5 Ousok ) b T - |
) DX fle (Outiock Bxpress ) / ‘
o " |

Figure 5.1: Select Output Typedialog

2. Theselection of PST file (MS Outlook) option displays the “Select Filter (s)” dialog. Select the desired filter
options, and then click the Next button to proceed.
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Solect Fittor(s) x

Select the desired Milters 10 save spedific data (Optional).

from Yo Subjet FoldetName RemType Deote Range ’

nchde [A3 >

IConm ' | X
Dons not Contar

To brwyes mxn sbot th siep glesss chok have, (Back |- Neas PR

Figure 5.2: Select Filter Dialog

3. After configuring the desired filter options, the "Manage Recovered PST" dialog box appears.

Manage Recovered PST x

Masmage recowered PST data using Spit cpBon and Attach prefix 1o store name

Split option © |’E'om‘wi"h vl

Sefect "Do not spit fie™ opbon € pou want 1o creste sngle PST e
Seloct othwer PST 30 1ol oplona, 1 pou mart 10 10l he FST Ne alier & particule 500

7 Astach prefix 1o store name |
Store name peefix :

Select "Altach peelu 1o stcre neme”™ ophon o add pesl to store nacse S will be vislile n M3 Datioo

To brow more abort the step, pinace chok have | cgack |- Ned» Carcal

Figure 5.3: Manage Recovered PST Dialog
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Here you can split the large sized PST file using the various split options:

Do not split file Select this option if you want to create a single PST file
Split file after 1 gb Select this option to split the pst into equal 1 GB files
Split file after 1.5 gb Select this option to split the pst into equal 1.5 GB files
Split file after 2 gb Select this option to split the pstinto equal 2 GB files
Split file after 2.5 gb Select this option to split the pst into equal 2.5 GB files
Split file after 3 gb Select this option to split the pst into equal 3 GB files
Split file after 3.5 gb Select this option to split the pst into equal 3.5 GB files
Split file after 4 gb Select this option to split the pst into equal 4 GB files
Split file after 5 gb Select this option to split the pstinto equal 5 GB files

> Note: Thereisan option ofadding a prefix to the Store Name, if you enable this option and type the
required prefix in the Store name prefix text box, then the recovered Store name will appear with the provided
prefix in Outlook

4. After clicking the Nextbuttoninthe “Managed Recovered PST” dialog, the “Select Destination Path”
dialog is displayed.
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Select Destination Path x

Selet Me desred CBO 10 save PST fle.

Sareng Pay | frowae

Chch. Browae and sedect o localon 10 save PST e

Eruchude doliod damn wivke trerg [(heck B option 1 you do rot wrd 10 sawe Soletod el

1 koeet nore sbok e ihen, sleaie chok here, cBok | Frish Biacil

Figure 5.4: Select Destination Path
5. Click the Browse button, the "Browse for Folder" dialog appears.

6. Select the desired location to save the recovered data, and then click the OK button.

Browse For Folder @

Select the Saving Location

@ Desktop

[+ LD My Documents

[# ﬂ My Computer

& %J My Network Places
() [pstlsetup

# [7) instant demo
() keywords =
() Mew Folder (4)

[>

(<€

Folder: i My Documents ’

[Make Mew Folder ] [ OK i [ Cancel ]

Figure 5.5: Browse for Folder

“Note: Select the “Exclude deleted items while saving” checkbox, to exclude saving deleted
items that are recovered from repaired PST file.
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7. Click the Finish button toinitiatethe saving process.

Please wait while current process finishes...

Saving 2 of 335

Saving Folder : Root - Mailbox\PM_SUBTREEN nbox'

Fw: Fw: images required

Cancel

Figure 5.6:Saving Process

8. After the saving process gets accomplished, the software displays the following success message:

-
Saved Files g

New PST file (s] saved successfully at:

To add PST file(s) in MS Dutlook, follow these steps:
Open MS Outlook >> Go to File Menu >> Click Dpen >> Select Open Data File >> Browse and select PST

file from drive
File Name Outlook Store Name
E:\RECOVEREDADMINISTRATOR - 49.PST RECOVEREDADMINISTRATOR - 43
| N

Figure 5.7:Saved Files dialog

To access the newly created PST file, you can click on the link given in the dialog box.
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5.2 Save In MSG

Select the MSG file option to saveall items in individual MSG files. In order to savethe recovered data in the
MSG file format, you can follow the instructions given below:

1. After the successful recovery of data files, email items are enlisted in the Left Pane, click the Save buttonin
the Toolbar for initiating the saving process.

2. By clicking the Save button, the “Select Output Type” dialogis displayed. Select the MSG file option, and then
click the Next button.

| Seloct Output Type x

Select the output type 10 save e recovered data

Single Fie
& PST be [ MS Dutiock )
{23 DEO e |0usfiock. Enprass|
LAMEBOX i
Hukiple Files
BANSG e
{2 ENL e
v 1T lhe
B RTF fe
SR HTML e
11 MHTHL Ne
BB FOF fie
Emad Serverz
) Oce %5
6 Gooupesse
# 1BM Doenree | Lotus Dioming |

Yo bnow nen shout e shap plaaee clok hese. " [tiotor Concel

Figure 5.8:Select Output Typedialog

3. Click onthe "Next" button and definethe respective filter criterion, the 'Select Destination Path' window
follows asking for saving path.
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Setect Destination Path x|

Select the desired location to sve PST Sle,

Sareigy Patn | Erowee
Chch Baowie and select a locaton 1o save PST Me

Enchude deleted fems whie sovng [ICheck ths option € you do not want 10 save deleted terisl)

To brgws moes shout ey slep pleaee clck heve,

<Bock | Famh Cancel

Figure 5.9: Select Destination Path

4. Click the Browse button tolocatethe place for savingthe MSG file that subsequently displays the Browse For
Folder dialog box.

Browse For Folder @

Select the Saving Location

@ Desktop

LD My Documents

[+ ﬂ My Computer

& % My Network Places
() [pst]setup

[# 1) instant demo
() keywords =
() New Folder (4)

|>

(<€

Folder: ‘ My Documents ’

[Make New Folder ] [ ok ;|[ Cancel ] »

Figure 5.10: Browsefor Folder dialog

5. Click the OK buttoninthe "Browse for Folder" dialog for assigning the folder to save the MSGfiles.
6. Click the Finish button toinitiatethe saving process.
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Please wait while current process finishes...

i =

Saving 2 of 335

Saving Folder : Root - Mailbox:IPM_SUBTREE\nbox'

Fw: Fw: images required

[

Cancel

Figure 5.11:Saving Process

7. After the saving process gets completed, the software displays the following success message.

Saved Files X

MSG files have been saved successfully to the following location:

C:\Documents and SettingshE shaj\Desktop

.................................

..................................

Figure 5.12:Saved in MSG

To access the newly created MSG file, you can click on the link given in the dialog.

5.3 Savein EML

Select the EMLfileoption to savethe recovered datain individual EML files. The following process depicts the
step-by-step process of saving the recovered items in EML file format:

1. After the recovered data is enlisted in the Left Pane, click the Save button, which displays the "Select Output
type" dialogbox.
2. Tosavetherecovered datain EML file format, select the EML file option.
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Select Output Type E3

Setenl the outiput type 10 Sive the jecovered data.

Sarvger Frbe
L PST e ( MS Outiook )

2 DX e { Outionck Exgrena |

(o}

Magle Fes

BANSG e

(e e e D— -
o TXT e

e FTF the

R HTV e 4
3 MHTML fe

Figure 5.13: Select Output Typedialog

3. After selecting the EMLfile option, click the Next button, and then proceed by applying the desired filter
options which then displays the “Select Destination Path” dialog.

Select Destination Path x|
Select the desited location to save PST Ne,
Saergy Pan | Erowse
Chch. Browae and select a location 1o save PST Me
Enchude deleted tems whie savng ICheck ths option ¢ you do not want 10 save deleted teds])
To brges mees abost ey siep plesee clck hete,
<Bock | Femh Cancel

Figure 5.14: Select Destination Path dialog

4. Inthe “Select Destination Path" dialog, after you click the Browse button, the “Browse For Folder” dialog gets
displayed. Set the desired saving location for saving the recovered EML file.
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Browse For Folder

Select the Saving Location

@ Deskrop

= lf:} My Documents

@ d My Computer

# %4 My Network Places
() [pstlsetup

# ) instant demo
() keywords =
) MNew Folder {4)

(2

4

Folder: | My Documents |

[ Make New Folder ] [ OK { [ Cancel ]

Figure 5.15: Browse for Folder

5. After the desired configurations of saving location. Click the Finish button to initiate the saving process:

Please wait while current process finishes...

w =

Saving 2 of 335

Saving Folder : Root - Mailbox\PM_SUBTREEMnboxs

Fw: Fw: images required

Cancel

Figure 5.16: File Saving Process

6. After the saving process gets completed, the software displays the following success message:

Saved Files X

EML files have been saved successfully ta the following location:

EA

o 0K

Figure 5.17: Saved Files dialog
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6. File Analysis Reports

The Kernel for Outlook PST software has been integrated with the facility to showcase the graphical File Analysis
Reports showing the logs of four different parameters. These reports can be generated after adding and repairing
the PST files. To view the reports, click the required report name in the bottom of the Task Pane, after repairing
the PST file. The reports can be generated onthe basis of the following attributes:

e Totalitem types
e Mail flow density by date
e Mail flow density by senders

e |nteraction between users

6.1 Total Item types

The "Total item types" bar-graph shows a categorized view of all message classes. Users can view the count of
each class in the graphical view or the tabular view.

Find Meszage(s) B

Lock n
v Crlisery admnistiator Des
MY CuserradmnstitorDes dnand
[#)3 Frosbuvy Data
528 1PN COMMON VItws
= L R Total item types
M Sean Roat
1) BP0l Top of Outisol data te 4)
¥l Catenda
Ma Contacts
.3 Conversation Ak
¥4 Deleted Nems
. Orary
M3 Gyana
= 8.4 nbox
M am
G roumal
¥ 2 enkt-mat
Ei News Feed Oum
- o AT B
M3 Quick Sep Settings FEPORTPM Ne
M2 RS Teess 1PN Scractin N
M Sent ema PN Momsoh 50
%v'\ tatky o
’ 1PN Mook Sr
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Court
3%
2

2

2

2

Figure 6.1: Total item types report

6.2 Mail flow density by date

The "Mail flow density by date" graph report shows the mail flow density on a different range of dates. It can also
show the number of messages on different dates in the graphical bar-graph format.
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Figure 6.2: Mail flow density by date reports

6.3 Mail flow density by senders

The "Mail flow density by senders" graph report categorizes emails accordingto its senders. You can view the
number of emails sent by senders for analysis purposes.
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Figure 6.3: Mail flow density by senders report
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6.4 Interaction between users

The "Interaction between users" graph shows the number of mail interactions amongst various users. The
interaction between a particular sender and receiver can easily be noted from this graph.
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Figure 6.4: Interaction between users report

6. Troubleshooting

This section deals with your generic and specific queries pertainingto using Kernel for Outlook PST Repair.

6.1 Common Issues
Why does Kernel for Outlook PST Repair have limitationsin the evaluation copy?

Although you can run Kernel for Outlook PST Repair evaluation version for free, and then experience the
capabilities of the software, but there are certain features thatare notavailable in the evaluation version. By
using the evaluation version of Kernel for Outlook PST Repair, you can repair corrupt.pstfiles; however, you
cannotsave more than 25 email items of each folder.

6.2 Frequently Asked Questions
How to Buy Kernel for Outlook PST Repair?
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You can buy Kernel for Outlook PST Repair online at https://www.nucleustechnologies.com/BuyMicrosoft-

Outlook-Mails-Recovery-Software.php

I have lost my full version for Kernel for Outlook PST Repair. Can you help me?

Please email us at sales@nucleustechnologies.com Pleaseinclude your name, address, email address, and order
confirmation number (if you haveit). We will be happy tohelp you.

| cannot view the Status Bar. How can| view it?

The Status Bar in Kernel for Outlook PST Repair is by default visible. It might have become invisible by someone
accidentally changing the settings

Click View->Status Bar to make the Status Bar visible again

The free trial version of Kernel for Outlook PST Repair software can be downloaded using the link:

https://www.nucleustechnologies.com/outlook-pst-repair.html

/. Support

Connectto our experts immediately while facing any issues during installation, configuration, or
associated matters:

* 1-866-348-7872
* 0-808-189-1438

Additionally, you can connect with us at https://www.nucleustechnologies.com/Contact.html to

submityour query, or chat with one of our supportteam.
Moreover, you can write to us at the following email addresses:

e sales@nucleustechnologies.com (forSales Queries)

e support@nucleustechnologies.com (for Support Queries)

8. Copyright

KernelApps Private Limited accompanied Installation & configuration manual, and documentation
is copyright of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this
user manual cannot be reproduced in any form without the prior written permission of
KernelApps Private Limited. No Patent Liability is assumed, with respect to the use of the
information contained herein.

© KernelApps Private Limited. All rights reserved.

-end-
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